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This device complies with part 15 of the FCC Rules. Operation is subject to the following two
conditions:

(1) This device may not cause harmful interference, and

(2) this device must accept any interference received, including interference that may cause
undesired operation.

Copyright Notice

Copyright Hemisphere GNSS, Inc. (2013). All rights reserved.

No part of this manual may be reproduced, transmitted, transcribed, stored in a retrieval system or
translated into any language or computer language, in any form or by any means, electronic,
mechanical, magnetic, optical, chemical, manual or otherwise, without the prior written
permission of Hemisphere GNSS.

Trademarks

Hemisphere GPS®, the Hemisphere GPS logo, COAST™, Crescent®, Earthworks®, Eclipse™, e-Dif®,
L-Dif™, miniEclipse™, PocketMAX PC™, PocketMAX™, PocketMax3™, S320™, SBX-4™,
SureTrack®, Vector™, XF1™, and XF2™ are proprietary trademarks of Hemisphere GNSS, Inc.
Other trademarks are the properties of their respective owners.

Patents

Hemisphere GNSS products may be covered by one or more of the following patents:
U.S. Patents Australia Patents
6111549 6876920 7400956 8000381 8214111 2002244539
6397147 7142956 7429952 8018376 8217833 2002325645
6469663 7162348 7437230 8085196 8265826 2004320401

6501346 7277792 7460942 8102325 8271194
6539303 7292185 7689354 8138970 8307535
6549091 7292186 7808428 8140223 8311696
6711501 7373231 7835832 8174437 8334804
6744404 7388539 7885745 8184050 RE41358
6865465 7400294 7948769 8190337

Other U.S. and foreign patents pending.

Notice to Customers
Contact your local dealer for technical assistance. To find the authorized dealer near you:

Hemisphere GNSS, Inc.

8444 N 90th St, Suite 120
Scottsdale, AZ 85258 USA
Phone: (480) 348-9919

Fax: (480) 348-6370

precision @hemispheregps.com
www.hemispheregps.com

Technical Support
If you need to contact Hemisphere GNSS Technical Support:

Hemisphere GNSS, Inc.

8444 N 90th St, Suite 120
Scottsdale, AZ 85258 USA

Phone: (480) 348-9919

Fax: (480) 348-6370
techsupport@hemispheregps.com

Documentation Feedback

Hemisphere GNSS is committed to the quality and continuous improvement of our products and
services. We urge you to provide Hemisphere GNSS with any feedback regarding this guide by
writing to the following email address: techsupport@hemispheregps.com.



Warranty Notice

COVERED PRODUCTS: This warranty covers all products manufactured by Hemisphere GPS and purchased by the end
purchaser (the "Products"), unless otherwise specifically and expressly agreed in writing by Hemisphere GPS.

LIMITED WARRANTY: Hemisphere GPS warrants solely to the end purchaser of the Products, subject to the exclusions
and procedures set forth below, that the Products sold to such end purchaser and its internal components shall be free,
under normal use and maintenance, from defects in materials, and workmanship and will substantially conform to
Hemisphere GPS's applicable specifications for the Product, for a period of 12 months from delivery of such Product to
such end purchaser (the "Warranty Period”). Repairs and replacement components for the Products are warranted, subject
to the exclusions and procedures set forth below, to be free, under normal use and maintenance, from defects in material
and workmanship, and will substantially conform to Hemisphere GPS’s applicable specifications for the Product, for 90
days from performance or delivery, or for the balance of the original Warranty Period, whichever is greater.

EXCLUSION OF ALL OTHER WARRANTIES. The LIMITED WARRANTY shall apply only if the Product is properly and
correctly installed, configured, interfaced, maintained, stored, and operated in accordance with Hemisphere GPS'’s relevant
User’s Manual and Specifications, AND the Product is not modified or misused. The Product is provided “AS IS” and the
implied warranties of MERCHANTABILITY and FITNESS FOR A PARTICULAR PURPOSE and ALL OTHER WARRANTIES,
express, implied or arising by statute, by course of dealing or by trade usage, in connection with the design, sale,
installation, service or use of any products or any component thereof, are EXCLUDED from this transaction and shall not
apply to the Product. The LIMITED WARRANTY is IN LIEU OF any other warranty, express or implied, including but not
limited to, any warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE, title, and non-infringement.

LIMITATION OF REMEDIES. The purchaser’s EXCLUSIVE REMEDY against Hemisphere GPS shall be, at Hemisphere
GPS's option, the repair or replacement of any defective Product or components thereof. The purchaser shall notify
Hemisphere GPS or a Hemisphere GPS'’s approved service center immediately of any defect. Repairs shall be made
through a Hemisphere GPS approved service center only. Repair, modification or service of Hemisphere GPS products by
any party other than a Hemisphere GPS approved service center shall render this warranty null and void. The remedy in
this paragraph shall only be applied in the event that the Product is properly and correctly installed, configured, interfaced,
maintained, stored, and operated in accordance with Hemisphere GPS'’s relevant User’s Manual and Specifications, AND
the Product is not modified or misused. NO OTHER REMEDY (INCLUDING, BUT NOT LIMITED TO, SPECIAL, INDIRECT,
INCIDENTAL, CONSEQUENTIAL OR CONTINGENT DAMAGES FOR LOST PROFITS, LOST SALES, INJURY TO PERSON OR
PROPERTY, OR ANY OTHER INCIDENTAL OR CONSEQUENTIAL LOSS) SHALL BE AVAILABLE TO PURCHASER, even if
Hemisphere GPS has been advised of the possibility of such damages. Without limiting the foregoing, Hemisphere GPS
shall not be liable for any damages of any kind resulting from installation, use, quality, performance or accuracy of any
Product.

HEMISPHERE IS NOT RESPONSIBLE FOR PURCHASER’S NEGLIGENCE OR UNAUTHORIZED USES OF THE
PRODUCT. IN NO EVENT SHALL HEMISPHERE GPS BE IN ANY WAY RESPONSIBLE FOR ANY DAMAGES RESULTING
FROM PURCHASER’S OWN NEGLIGENCE, OR FROM OPERATION OF THE PRODUCT IN ANY WAY OTHER THAN AS
SPECIFIED IN HEMISPHERE GPS’S RELEVANT USER’S MANUAL AND SPECIFICATIONS. Hemisphere GPS is NOT
RESPONSIBLE for defects or performance problems resulting from (1) misuse, abuse, improper installation, neglect of
Product; (2) the utilization of the Product with hardware or software products, information, data, systems, interfaces or
devices not made, supplied or specified by Hemisphere GPS; (3) the operation of the Product under any specification other
than, or in addition to, the specifications set forth in Hemisphere GPS's relevant User’s Manual and Specifications; (4)
damage caused by accident or natural events, such as lightning (or other electrical discharge) or fresh/salt water
immersion of Product; (5) damage occurring in transit; (6) normal wear and tear; or (7) the operation or failure of operation
of any satellite-based positioning system or differential correction service; or the availability or performance of any
satellite-based positioning signal or differential correction signal.

THE PURCHASER IS RESPONSIBLE FOR OPERATING THE VEHICLE SAFELY. The purchaser is solely responsible
for the safe operation of the vehicle used in connection with the Product, and for maintaining proper system control
settings. UNSAFE DRIVING OR SYSTEM CONTROL SETTINGS CAN RESULT IN PROPERTY DAMAGE, INJURY, OR DEATH.
The purchaser is solely responsible for his/her safety and for the safety of others. The purchaser is solely responsible for
maintaining control of the automated steering system at all times. THE PURCHASER IS SOLELY RESPONSIBLE FOR
ENSURING THE PRODUCT IS PROPERLY AND CORRECTLY INSTALLED, CONFIGURED, INTERFACED, MAINTAINED,
STORED, AND OPERATED IN ACCORDANCE WITH HEMISPHERE GPS’S RELEVANT USER’'S MANUAL AND
SPECIFICATIONS. Hemisphere GPS does not warrant or guarantee the positioning and navigation precision or accuracy
obtained when using Products. Products are not intended for primary navigation or for use in safety of life applications.
The potential accuracy of Products as stated in Hemisphere GPS literature and/or Product specifications serves to provide
only an estimate of achievable accuracy based on performance specifications provided by the satellite service operator (i.e.
US Department of Defense in the case of GPS) and differential correction service provider. Hemisphere GPS reserves the
right to modify Products without any obligation to notify, supply or install any improvements or alterations to existing
Products.

GOVERNING LAW. This agreement and any disputes relating to, concerning or based upon the Product shall be
governed by and interpreted in accordance with the laws of the State of Arizona.

OBTAINING WARRANTY SERVICE. In order to obtain warranty service, the end purchaser must bring the Product to a
Hemisphere GPS approved service center along with the end purchaser's proof of purchase. Hemisphere GPS does not
warrant claims asserted after the end of the warranty period. For any questions regarding warranty service or to obtain
information regarding the location of any of Hemisphere GPS approved service center, contact Hemisphere GPS at the
following address:

Hemisphere GPS

8444 N. 90th Street, Suite 130
Scottsdale, AZ 85258

Phone: 480-348-9919 Fax: 480-348-6370
techsupport@hemispheregps.com
www.hemispheregps.com
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25.
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27.

28.

TERMINATION. Licensee may terminate this Agreement at any time without cause. Hemisphere may terminate this
Agreement on 30 days notice to Licensee if Licensee fails to materially comply with each provision of this
Agreement unless such default is cured within the 30 days. Any such termination by a party shall be in addition to
and without prejudice to such rights and remedies as may be available, including injunction and other equitable
remedies. Upon receipt by Licensee of written notice of termination from Hemisphere or termination by Licensee,
Licensee shall at the end of any notice period (a) cease using the Software; and (b) return to Hemisphere (or destroy
and provide a certificate of a Senior Officer attesting to such destruction) the Software and all related material and
any magnetic or optical media provided to Licensee. The provisions of Sections 6), 7), 8), 9), 10), 15), 21), 26) and 27)
herein shall survive the expiration or termination of this Agreement for any reason.

EXPORT RESTRICTIONS. Licensee agrees that Licensee will comply with all export control legislation of Canada,
the United States, Australia and any other applicable country's laws and regulations, whether under the Arms
Export Control Act, the International Traffic in Arms Regulations, the Export Administration Regulations, the
regulations of the United States Departments of Commerce, State, and Treasury, or otherwise as well as the export
control legislation of all other countries.

PRODUCT COMPONENTS. The Product may contain third party components. Those third party components may
be subject to additional terms and conditions. Licensee is required to agree to those terms and conditions in order to
use the Product.

FORCE MAJEURE EVENT. Neither party will have the right to claim damages as a result of the other's inability to
perform or any delay in performance due to unforeseeable circumstances beyond its reasonable control, such as
labor disputes, strikes, lockouts, war, riot, insurrection, epidemic, Internet virus attack, Internet failure, supplier
failure, act of God, or governmental action not the fault of the non-performing party.

FORUM FOR DISPUTES. The parties agree that the courts located in the State of Arizona and the courts of appeal
there from will have exclusive jurisdiction to resolve any disputes between Licensee and Hemisphere concerning
this Agreement or Licensee's use or inability to use the Software and the parties hereby irrevocably agree to attorn
to the jurisdiction of those courts. Notwithstanding the foregoing, either party may apply to any court of competent
jurisdiction for injunctive relief.

APPLICABLE LAW. This Agreement shall be governed by the laws of the State of Arizona, exclusive of any of its
choice of law and conflicts of law jurisprudence.

CISG. The United Nations Convention on Contracts for the International Sale of Goods will not apply to this
Agreement or any transaction hereunder.

GENERAL. This is the entire agreement between Licensee and Hemisphere relating to the Product and Licensee's
use of the same, and supersedes all prior, collateral or contemporaneous oral or written representations, warranties
or agreements regarding the same. No amendment to or modification of this Agreement will be binding unless in
writing and signed by duly authorized representatives of the parties. Any and all terms and conditions set out in any
correspondence between the parties or set out in a purchase order which are different from or in addition to the
terms and conditions set forth herein, shall have no application and no written notice of same shall be required. In
the event that one or more of the provisions of this Agreement is found to be illegal or unenforceable, this
Agreement shall not be rendered inoperative but the remaining provisions shall continue in full force and effect.



20.

positioning and navigation accuracy obtainable with the Software as stated in the Product or Software
documentation serves to provide only an estimate of achievable accuracy based on specifications provided by the
US Department of Defense for GPS positioning and DGPS service provider performance specifications, where
applicable.

WARRANTY DISCLAIMER. EXCEPT AS EXPRESSLY SET OUT IN THIS AGREEMENT, HEMISPHERE MAKES NO
REPRESENTATION, WARRANTY OR CONDITION OF ANY KIND TO LICENSEE, WHETHER VERBAL OR WRITTEN
AND HEREBY DISCLAIMS ALL REPRESENTATIONS, WARRANTIES AND CONDITIONS OF ANY KIND INCLUDING
FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, ACCURACY, RELIABILITY OR THAT THE USE OF THE
SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE AND HEREBY DISCLAIMS ALL REPRESENTATIONS,
WARRANTIES AND CONDITIONS ARISING AS A RESULT OF CUSTOM, USAGE OR TRADE AND THOSE ARISING
UNDER STATUTE.

LIMITS ON WARRANTY DISCLAIMER. Some jurisdictions do not allow the exclusion of implied warranties or
conditions, so some of the above exclusions may not apply to Licensee. In that case, any implied warranties or
conditions which would then otherwise arise will be limited in duration to ninety (90) days from the date of the
license of the Software or the purchase of the Product. The warranties given herein give Licensee specific legal rights
and Licensee may have other rights which may vary from jurisdiction to jurisdiction.

CHANGE TO WARRANTY. No employee or agent of Hemisphere is authorized to change the warranty provided or
the limitation or disclaimer of warranty provisions. All such changes will only be effective if pursuant to a separate
agreement signed by senior officers of the respective parties.

WARRANTY CLAIM. In the event Licensee has a warranty claim Licensee must first check for and install all
Updates that are made available. The warranty will not otherwise be honored. Proof of purchase may be required.
Hemisphere does not honor claims asserted after the end of the Warranty Period.

LICENSEE REMEDIES. In all cases which involve a failure of the Software to conform in any material respect to the
documentation during the Warranty Period or a breach of a warranty, Hemisphere's sole obligation and liability, and
Licensee's sole and exclusive remedy, is for Hemisphere, at Hemisphere's option, to (a) repair the Software, (b)
replace the Software with software conforming to the documentation, or (c) if Hemisphere is unable, on a
reasonable commercial basis, to repair the Software or to replace the Software with conforming software within
ninety (90) days, to terminate this Agreement and thereafter Licensee shall cease using the Software. Hemisphere
will also issue a refund for the price paid by Licensee less an amount on account of amortization, calculated on a
straight-line basis over a deemed useful life of three (3) years.

LIMITATION OF LIABILITY. IN NO EVENT WILL HEMISPHERE BE LIABLE TO LICENSEE FOR ANY INCIDENTAL,
CONSEQUENTIAL, SPECIAL OR INDIRECT DAMAGES INCLUDING ARISING IN RELATION TO ANY LOSS OF DATA,
INCOME, REVENUE, GOODWILL OR ANTICIPATED SAVINGS EVEN IF HEMISPHERE HAS BEEN INFORMED OF THE
POSSIBILITY OF SUCH LOSS OR DAMAGE. FURTHER, IN NO EVENT WILL HEMISPHERE'S TOTAL CUMULATIVE
LIABILITY HEREUNDER, FROM ALL CAUSES OF ACTION OF ANY KIND, EXCEED THE TOTAL AMOUNT PAID BY
LICENSEE TO HEMISPHERE TO PURCHASE THE PRODUCT. THIS LIMITATION AND EXCLUSION APPLIES
IRRESPECTIVE OF THE CAUSE OF ACTION, INCLUDING BUT NOT LIMITED TO BREACH OF CONTRACT,
NEGLIGENCE, STRICT LIABILITY, TORT, BREACH OF WARRANTY, MISREPRESENTATION OR ANY OTHER LEGAL
THEORY AND WILL SURVIVE A FUNDAMENTAL BREACH.

LIMITS ON LIMITATION OF LIABILITY. Some jurisdictions do not allow for the limitation or exclusion of liability for
incidental or consequential damages, so the above limitation or exclusion may not apply to Licensee and Licensee
may also have other legal rights which may vary from jurisdiction to jurisdiction.

BASIS OF BARGAIN. Licensee agrees and acknowledges that Hemisphere has set its prices and the parties have
entered into this Agreement in reliance on the limited warranties, warranty disclaimers and limitations of liability set
forth herein, that the same reflect an agreed-to allocation of risk between the parties (including the risk that a
remedy may fail of its essential purpose and cause consequential loss), and that the same forms an essential basis
of the bargain between the parties. Licensee agrees and acknowledges that Hemisphere would not have been able
to sell the Product at the amount charged on an economic basis without such limitations.

PROPRIETARY RIGHTS INDEMNITY. Hemisphere shall indemnify, defend and hold harmless Licensee from and
against any and all actions, claims, demands, proceedings, liabilities, direct damages, judgments, settlements, fines,
penalties, costs and expenses, including royalties and attorneys' fees and related costs, in connection with or arising
out of any actual infringement of any third party patent, copyright or other intellectual property right by the Software
or by its use, in accordance with this Agreement and documentation, PROVIDED THAT: (a) Hemisphere has the right
to assume full control over any action, claim, demand or proceeding, (b) Licensee shall promptly notify Hemisphere
of any such action, claim, demand, or proceeding, and (c) Licensee shall give Hemisphere such reasonable
assistance and tangible material as is reasonably available to Licensee for the defense of the action, claim, demand
or proceeding. Licensee shall not settle or compromise any of same for which Hemisphere has agreed to assume
responsibility without Hemisphere's prior written consent. Licensee may, at its sole cost and expense, retain
separate counsel from the counsel utilized or retained by Hemisphere.

INFRINGEMENT. If use of the Software may be enjoined due to a claim of infringement by a third party then, at its
sole discretion and expense, Hemisphere may do one of the following: (a) negotiate a license or other agreement so
that the Product is no longer subject to such a potential claim, (b) modify the Product so that it becomes non-
infringing, provided such modification can be accomplished without materially affecting the performance and
functionality of the Product, (c) replace the Software, or the Product, with non-infringing software, or product, of
equal or better performance and quality, or (d) if none of the foregoing can be done on a commercially reasonable
basis, terminate this license and Licensee shall stop using the Product and Hemisphere shall refund the price paid by
Licensee less an amount on account of amortization, calculated on a straight-line basis over a deemed useful life of
three (3) years.

The foregoing sets out the entire liability of Hemisphere and the sole obligations of Hemisphere to Licensee in
respect of any claim that the Software or its use infringes any third party rights.

INDEMNIFICATION. Except in relation to an infringement action, Licensee shall indemnify and hold Hemisphere
harmless from any and all claims, damages, losses, liabilities, costs and expenses (including reasonable fees of
lawyers and other professionals) arising out of or in connection with Licensee's use of the Product, whether direct or
indirect, including without limiting the foregoing, loss of data, loss of profit or business interruption.
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Chapter 1: Introduction

What's In This Guide?

This User Guide provides the following information to get you up and running quickly
with your Vector™ VS131™ GPS compass.

° This chapter briefly describes the VS131 and the parts in your VS131 kit.

° Chapter 2, “Understanding the VS131” discusses GPS and differential
operation as well as sensors and time constants related to the VS131.

o Chapter 3, “Installing the VS131” describes how to mount the antennas and
receiver, connect the cables, and power the system.

o Chapter 4, “Operating the VS131"” provides instructions on configuring the
receiver, disabling aiding features, adjusting the time constants, and
operating the receiver.

° Appendix A, “Troubleshooting” provides possible solutions for issues.
. Appendix B, “FAQ” includes answer to common questions.
° Appendix C, “Menu Map” provides a full map of all system menus.

o Appendix D, “Technical Specifications” lists the technical specifications of
the VS131 and the included antennas.

Note: Throughout the rest of this user guide the Vector VS131 GPS Compass is
referred to simply as the VS131.

Product Overview

The VS131 provides a highly-accurate GPS
heading that takes into account the pitch, roll, and
speed of various vehicles and vessels and is ideal
for professional machine control and navigation
applications in areas where either beacon or L-
band positioning can be achieved. Featuring a
Hemisphere GPS Crescent® Vector-based receiver
and two separate antennas, VS131 achieves
heading accuracy ranging from 0.03° to 0.33° rms
(depending on the antenna separation) and offers
robust positioning performance.

With more accurate code phase measurements,
improved multipath mitigation and fewer
components than competing products, VS131 offers superior accuracy and stability.

The VS131 receiver, with its display and user interface, can be conveniently installed
near the operator, while the two antennas are mounted separately with a user-
determined separation (up to 5 m) to meet the desired accuracy.

VS131 uses L-band, SBAS (WAAS, EGNOS, MSAS, etc.), or beacon for differential GPS
positioning—offering differential positioning performance of less than 0.6 m 95% of
the time.

VS131 also features Hemisphere GPS’ exclusive COAST™ technology that enables
Hemisphere GPS receivers to utilize aging differential GPS correction data for 40
minutes or more without significantly affecting positioning quality. VS131 is less likely
to be affected by differential signal outages due to signal blockages, weak signals, or
interference when using COAST.

Vector VS131 GPS Compass User Guide 2 PN 875-0311-000 Rev B1

End User License Agreement

IMPORTANT - This is an agreement (the "Agreement") between you, the end purchaser ("Licensee") and Hemisphere
GNSS Inc. ("Hemisphere") which permits Licensee to use the Hemisphere software (the "Software") that accompanies
this Agreement. This Software may be licensed on a standalone basis or may be embedded in a Product. Please read and
ensure that you understand this Agreement before installing or using the Software Update or using a Product.

In this agreement any product that has Software embedded in it at the time of sale to the Licensee shall be referred to as a
"Product". As well, in this Agreement, the use of a Product shall be deemed to be use of the Software which is embedded
in the Product.

BY INSTALLING OR USING THE SOFTWARE UPDATE OR THE PRODUCT, LICENSEE THEREBY AGREES TO BE LEGALLY
BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THESE TERMS, (I) DO NOT INSTALL OR USE
THE SOFTWARE, AND (Il) IF YOU ARE INSTALLING AN UPDATE TO THE SOFTWARE, DO NOT INSTALL THE UPDATE AND
PROMPTLY DESTROY IT.

HEMISPHERE PROVIDES LIMITED WARRANTIES IN RELATION TO THE SOFTWARE. AS WELL, THOSE WHO USE THE
EMBEDDED SOFTWARE DO SO AT THEIR OWN RISK. YOU SHOULD UNDERSTAND THE IMPORTANCE OF THESE AND
OTHER LIMITATIONS SET OUT IN THIS AGREEMENT BEFORE INSTALLING OR USING THE SOFTWARE OR THE PRODUCT.

1.

LICENSE. Hemisphere hereby grants to Licensee a non-transferable and non-exclusive license to use the Software
as embedded in a Product and all Updates (collectively the "Software"), solely in binary executable form.

RESTRICTIONS ON USE. Licensee agrees that Licensee and its employees will not directly or indirectly, in any
manner whatsoever:

a. install or use more copies of the Software than the number of copies that have been licensed;

b. use or install the Software in connection with any product other than the Product the Software was intended
to be used or installed on as set out in the documentation that accompanies the Software.

c. copy any of the Software or any written materials for any purpose except as part of Licensee's normal backup
processes;

d modify or create derivative works based on the Software;
e sub-license, rent, lease, loan or distribute the Software;

f. permit any third party to use the Software;
g

use or operate Product for the benefit of any third party in any type of service outsourcing, application service,
provider service or service bureau capacity;

h. reverse engineer, decompile or disassemble the Software or otherwise reduce it to a human perceivable form;

i Assign this Agreement or sell or otherwise transfer the Software to any other party except as part of the sale
or transfer of the whole Product.

UPDATES. At Hemisphere's discretion Hemisphere may make Updates available to Licensee. An update
("Update") means any update to the Software that is made available to Licensee including error corrections,
enhancements and other modifications. Licensee may access, download and install Updates during the Warranty
Period only. All Updates that Licensee downloads, installs or uses shall be deemed to be Software and subject to this
Agreement. Hemisphere reserves the right to modify the Product without any obligation to notify, supply or install
any improvements or alterations to existing Software.

SUPPORT. Hemisphere may make available directly or through its authorized dealers telephone and email support
for the Software. Contact Hemisphere to find the authorized dealer near you. As well, Hemisphere may make
available user and technical documentation regarding the Software. Hemisphere reserves the right to reduce and
limit access to such support at any time.

BACKUPS AND RECOVERY. Licensee shall back-up all data used, created or stored by the Software on a regular
basis as necessary to enable proper recovery of the data and related systems and processes in the event of a
malfunction in the Software or any loss or corruption of data caused by the Software. Licensee shall assume all risks
of loss or damage for any failure to comply with the foregoing.

OWNERSHIP. Hemisphere and its suppliers own all rights, title and interest in and to the Software and related
materials, including all intellectual property rights. The Software is licensed to Licensee, not sold.

TRADEMARKS. “Hemisphere’, “Hemisphere GPS’ “Hemisphere GNSS’ “Crescent’; “Eclipse” and the associated
logos are trademarks of Hemisphere. Other trademarks are the property of their respective owners. Licensee may
not use any of these trademarks without the consent of their respective owners.

LIMITED WARRANTY. Hemisphere warrants solely to the Licensee, subject to the exclusions and procedures set
forth herein below, that for a period of one (1) year from the original date of purchase of the Product in which it is
embedded (the "Warranty Period"), the Software, under normal use and maintenance, will conform in all material
respects to the documentation provided with the Software and any media will be free of defects in materials and
workmanship. For any Update, Hemisphere warrants, for 90 days from performance or delivery, or for the balance of
the original Warranty Period, whichever is greater, that the Update, under normal use and maintenance, will
conform in all material respects to the documentation provided with the Update and any media will be free of
defects in materials and workmanship. Notwithstanding the foregoing, Hemisphere does not warrant that the
Software will meet Licensee's requirements or that its operation will be error free.

WARRANTY EXCLUSIONS. The warranty set forth in Section (8) will not apply to any deficiencies caused by (a)
the Product not being used as described in the documentation supplied to Licensee, (b) the Software having been
altered, modified or converted in any way by anyone other than Hemisphere approved by Hemisphere, (c) any
malfunction of Licensee's equipment or other software, or (d) damage occurring in transit or due to any accident,
abuse, misuse, improper installation, lightning (or other electrical discharge) or neglect other than that caused by
Hemisphere. Hemisphere does not warrant or guarantee the precision or accuracy of positions obtained when using
the Software (whether standalone or embedded in a Product). The Product and the Software is not intended and
should not be used as the primary means of navigation or for use in safety of life applications. The potential
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Key Features
Key features of the VS131 include:

High-precision positioning in L1, SBAS, beacon, and L-band (beacon and
L-band require an unlock code)

Heave of 30 cm rms (DGPS)

Pitch and roll < 1° rms

Simple menu operations

Accurate heading up to 3 minutes during GPS outages

Integrated gyro and tilt sensors deliver fast startup times and provide
heading updates during temporary loss of GPS

What's Included in Your Kit

Your VS131 kit (Figure 1-1) includes the following parts:

VS131 receiver and related mounting hardware
Power and data cables

Note: The standard VS131 kit does not include antennas, antenna mounting
hardware, and antenna cables since receiver options vary.

Figure 1-1: VS131 system parts diagram

Table 1-1 on page 4 provides the description and part number of each part in your kit.

Review the parts shipped with your kit: if any parts are damaged, contact your freight
carrier. If any parts are missing, contact your dealer.
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Table 1-1: Parts list

Item Part Name Qty Part Number

A VS131 receiver 1 803-3022-000#

B Receiver mounting kit 1 710-0056-000#
(two brackets and related hardware)

C Power cable, circular 1 054-0118-000#

D Data cable, DB-9 female to DB-9 male, 3 m 1 050-0011-022#

The following are available for purchase separately from the standard VS131 kit.

E Antenna (quantity of each based on your
purchased configuration)
A21 804-3036-000#
A31 804-3043-000#
F Antenna mounting kit (quantity of each based on
your purchased configuration)
A21 antenna mounting kit 710-0110-000#
A31 antenna mounting kit 710-0111-000#
Note: Your kit may not include a mag mount.
G Antenna cable, TNC male to TNC male, 10 m 2 052-0004-000#

Using VectorPC to Communicate with the
VS131

Hemisphere GPS’ VectorPC is a free utility program that runs on your Windows PC or
Windows mobile device. Simply connect your Windows device to the VS131 via the
COM port and open VectorPC. The screens within VectorPC enable you to easily
interface with the VS131 to:

Select the internal SBAS, beacon, or L-band correction source, if available,
and monitor reception

Configure GPS message output and port settings
Review heading, pitch, and roll visually

Help calculate heading offset or heading bias

Help calculate heading offset or heading bias

VectorPC is available for download from the OEM Software Downloads page on the
Hemisphere GPS website (www.hemispheregps.com).
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GPS Overview

For your convenience, both the GPS and SBAS operation of the VS131 features
automatic operational algorithms. When powered for the first time, the VS131
performs a “cold start,” which involves acquiring the available GPS satellites in view
and the SBAS differential service.

Appendix D: Technical Specifications

Table D-19: A31 environmental specifications

Specification Description

Storage temperature -40°C to +85°C (-40°F to +185°F)

-30°C to +70°C (-22°F to +158°F)

Operating temperature

If SBAS is not available in your area, an external source of RTCM SC-104 differential Enclosure rating IP69K
corrections may be used. If you use an external source of correction data, it must Shock and vibration EP 455
support an eight data bit, no parity, one stop bit configuration (8-N-1). Humidity 95%, non-condensing

GPS Operation

The GPS receiver is always operating, regardless of the DGPS mode of operation. The
following sections describe the general operation of the VS131’s internal GPS receiver.

Note: Differential source have no impact on heading, pitch, or roll. It only has an
impact on positioning and heave.

Automatic Tracking

The VS131's internal GPS receiver automatically searches for GPS satellites, acquires
the signals, and manages the navigation information required for positioning and
tracking.

Receiver Performance

The VS131 works by finding four or more GPS satellites in the visible sky. It uses
information from the satellites to compute a position within 2.5 m. Since there is
some error in the GPS data calculations, the VS131 also tracks a differential correction.
The VS131 uses these corrections to improve its position accuracy to better than

0.6 m.

There are two main aspects of GPS receiver performance:

° Satellite acquisition
° Positioning and heading calculation

When the VS131 is properly positioned, the satellites transmit coded information to
the antennas on a specific frequency. This allows the receiver to calculate a range to
each satellite from both antennas. GPS is essentially a timing system. The ranges are
calculated by timing how long it takes for the signal to reach the GPS antenna. The
GPS receiver uses a complex algorithm incorporating satellite locations and ranges to
each satellite to calculate the geographic location and heading. Reception of any four
or more GPS signals allows the receiver to compute three-dimensional coordinates
and a valid heading.

Differential Operation

The purpose of differential GPS (DGPS) is to remove the effects of selective
availability (SA), atmospheric errors, timing errors, and satellite orbit errors, while
enhancing system integrity.

Autonomous positioning capabilities of the VS131 will result in positioning accuracies
of 2.5 m 95% of the time. To improve positioning quality to sub-meter levels, the
VS131 is able to use differential corrections received through the internal SBAS
demodulator or externally-supplied RTCM corrections.
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A31 Antenna Specifications
Table D-14 through Table D-19 list the technical specifications of the A31 antenna.

Table D-14: A31 GNSS sensor specifications

Specification

Description

GNSS reception

GPS, SBAS, L-band, and beacon

GNSS frequency 1.575 GHz (L1)
LNA gain 30dB
LNA noise <2.0dB

Table D-15: A31 L-Band sensor specifications

Specification

Description

L-Band frequency

1.5625 - 1.685 GHz

L-Band LNA gain

30 dB

Table D-16: A31 Beacon sensor specifications

Specification

Description

Beacon frequency

283.5 - 325 kHz

Beacon LNA gain

30 dB

Table D-17: A31 power specifications

Specification

Description

Input voltage

5to 12 VDC

Input current

50 to 60 mA

Table D-18: A31 mechanical specifications

Specification

Description

Enclosure Lexan
Dimensions 10.4 Hx 14.5 D (cm)
4.1 Hx5.7 D (in)
Weight 734 g (25.9 0z)
Mounting thread 1" coarse thread (5/8" adapter available)
Connector TNC
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In addition to these differential services the VS131 can also receive radiobeacon
corrections.

For more information on the differential services and the associated commands refer
to the Hemisphere GPS Technical Reference (go to www.hemispheregps.com and click
the GPS Reference icon).

Automatic SBAS Tracking

The VS131 automatically scans and tracks SBAS signals without the need to tune the
receiver. The VS131 features two-channel tracking that provides an enhanced ability to
maintain a lock on an SBAS satellite when more than one satellite is in view. This
redundant tracking approach results in more consistent tracking of an SBAS signal in
areas where signal blockage of a satellite is possible.

Beacon Operation

Many marine authorities, such as coast guards, have installed networks of
radiobeacons that broadcast DGPS corrections to users of this system. With the
increasing utility of these networks for terrestrial applications, there is an increasing
trend toward densification of these networks inland. The dual channel beacon receiver
in the VS131 can operate in manual or automatic tuning mode, or, using database
mode, will select the closest station in compliance with IEC 61108-4 standards.

L-Band

L-band corrections are available worldwide through third-party providers. With this
service, the positioning accuracy does not degrade as a function of distance to a base
station, as the data content is not composed of a single base station’s information, but
an entire network’s information.
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VS131 Overview

The VS131 provides accurate and reliable heading and position information at high
update rates. To accomplish this task, the VS131 uses a high performance GPS
receiver and two antennas for GPS signal processing. One antenna is designated as
the primary GPS antenna and the other is the secondary GPS antenna. Positions
computed by the VS131 are referenced to the phase center of the primary GPS
antenna. Heading data references the vector formed from the primary GPS antenna
phase center to the secondary GPS antenna phase center.

Fixed Baseline Moving Base Station RTK

The VS131's internal GPS receiver uses both the L1 GPS C/A code and carrier phase
data to compute the location of the secondary GPS antenna in relation to the primary
GPS antenna with a very high sub-centimeter level of precision. The technique of
computing the location of the secondary GPS antenna with respect to the primary
antenna, when the primary antenna is moving, is often referred to as moving base
station Real Time Kinematic (or moving base station RTK).

Generally, RTK technology is very sophisticated and requires a significant number of
possible solutions to be analyzed where various combinations of integer numbers of
L1 wavelengths to each satellite intersect within a certain search volume. The integer
number of wavelengths is often referred to as the “ambiguity” as they are initially
ambiguous at the start of the RTK solution.

The VS131 restricts the RTK solution by knowing that the secondary GPS antenna is a
fixed distance from the primary GPS antenna. The default value is 1.0 m, but you may
install the antennas with a different separation distance, then enter that value into the
VS131. This is called a fixed baseline and it defines the search volume of the
secondary antenna as the surface of a sphere with radius 1.0 m centered on the
location of the primary antenna (see Figure 2-1).

Primary antenna

[ [1.0 m baseline |
Figure 2-1: Secondary antenna’s search volume
Note: The VS131 moving base station algorithm only uses GPS to calculate heading.

Differential and RTK corrections are not used in this calculation and will not affect
heading accuracy.

Appendix D: Technical Specifications

A21 Antenna Specifications

Table D-9 through Table D-13 list the technical specifications of the A21 antenna.

Table D-9: A21 GNSS sensor specifications

Specification Description

GNSS reception GPS, SBAS, and L-band
GNSS frequency 1.5675 GHz (L1)

LNA gain 30dB

LNA noise <2.0dB

Table D-10: A21 L-Band sensor specifications

Specification Description
L-Band frequency 1.5625 - 1.585 GHz
L-Band LNA gain 30dB

Table D-11: A21 power specifications

Specification Description
Input voltage 3.3t0 12VDC
Input current 24 mA, typical

Table D-12: A21 mechanical specifications

Specification Description
Enclosure Aluminum base with ASA plastic cap
Dimensions 70H x 13.0 D (cm)
2.8 Hx5.1D (in)
Weight 380 g (13.4 0z2)
Mounting thread 5/8” female thread
RF connector TNC

Table D-13: A21 environmental specifications

Vector VS131 GPS Compass User Guide 8
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Specification

Description

Operating temperature

-30°C to +70°C (-22°F to +158°F)

Storage temperature

-40°C to +85°C (-40°F to +185°F)

Enclosure rating

IP69K

Shock and vibration

EP455

Humidity

96% non condensing
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Table D-6: VS131 environmental specifications

Item Specification

Operating temperature -30°C to +70°C (-22°F to +158°F)

Storage temperature -40°C to +85°C (-40°F to +185°F)
Humidity 95%, non-condensing
Enclosure rating IP66 (IEC 60529)
Shock and vibration Mechanical Shock: EP455 Section 5.14.1
Vibration: EP455 Section 5.15.1 Random
EMC CE (IEC 60945 Emissions and Immunity), FCC Part 15,

Subpart B, CISPR 22

IMO wheelmarked certification No

Table D-7: VS131 mechanical specifications

Item Specification

Dimensions 20.2L x12.0 Wx 75H (cm)
8.0Lx4.7Wx3.0H(in)

Weight ~1.1 kg (2.5 Ib)

Status indications (LEDs) Power, primary GPS lock, secondary GPS lock, differential
lock, DGPS position, heading, L-band lock

Power switch Front panel soft switch

Power connector 2-pin ODU metal circular

Data connectors (2) DB9 sealed

Antenna connectors (2) TNC female

Table D-8: Aiding devices

Item Specification

Gyro Provides smooth heading, fast heading reacquisition, and reliable < 1° per
minute heading for periods up to 3 minutes when loss of GPS has occurred.®

Tilt Provide pitch, roll data and assist in fast start-up and reacquisition of heading
Sensors | solution.

1Depends on multipath environment, number of satellites in view, and satellite geometry
2Requires a subscription from L-band service provider

3Based on a 40 second time constant

4Hemisphere GPS proprietary

5Under static conditions
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Supplemental Sensors

The VS131 has an integrated gyro and two tilt sensors, which are enabled by default.
Each supplemental sensor may be individually enabled or disabled. Both
supplemental sensors are mounted on the printed circuit board inside the VS131.

The sensors act to reduce the RTK search volume, which improves heading startup
and reacquisition times. This improves the reliability and accuracy of selecting the
correct heading solution by eliminating other possible, erroneous solutions.

The Hemisphere GPS Technical Reference (go to www.hemispheregps.com and click
the GPS Reference icon) describes the commands and methodology required to
recalibrate, query, or change the sensors status.

Tilt Aiding

The VS131's accelerometers (internal tilt sensors) are factory calibrated and enabled
by default. This constrains the RTK heading solution beyond the volume associated
with just a fixed antenna separation. This is because the VS131 knows the
approximate inclination of the secondary antenna with respect to the primary
antenna. The search space defined by the tilt sensor will be reduced to a horizontal
ring on the sphere’s surface by reducing the search volume. This considerably
decreases startup and reacquisition times (see Figure 2-2).

Tilt angle

Figure 2-2: VS131's tilt aiding

Gyro Aiding

The VS131's internal gyro offers several benefits. It reduces the sensor volume for an
RTK solution. This shortens reacquisition times when a GPS heading is lost because
the satellite signals were blocked. The gyro provides a relative change in angle since
the last computed heading, and, when used in conjunction with the tilt sensor, defines
the search space as a wedge-shaped location (see Figure 2-3).

Figure 2-3: VS131’s gyro aiding
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The gyro aiding accurately smoothes the heading output and the rate of turn. It
provides an accurate substitute heading for a short period depending on the roll and
pitch of the vessel, ideally seeing the system through to reacquisition. The gyro
provides an alternate source of heading, accurate to within 1° per minute for up to
three minutes, in times of GPS loss for either antenna. If the outage lasts longer than
three minutes, the gyro will have drifted too far and the VS131 begins outputting null
fields in the heading output messages. There is no user control over the timeout
period of the gyro.

The gyro initializes itself at powerup and during initialization, or you can calibrate it as
outlined in the Hemisphere GPS Technical Reference (go to www.hemispheregps.com
and click the GPS Reference icon). When the gyro is first initializing, it is important that
the dynamics that the gyro experiences during this warmup period are similar to the
regular operating dynamics. For example, if you use the VS131 on a high speed,
maneuverable craft, it is essential that when gyro aiding in the VS131 is first turned
on, use it in an environment that has high dynamics for the first five to ten minutes
instead of sitting stationary.

With the gyro enabled, the gyro is also used to update the post HTAU smoothed
heading output from the moving base station RTK GPS heading computation. This
means that if the HTAU value is increased while gyro aiding is enabled, there will be
little to no lag in heading output due to vehicle maneuvers. The Hemisphere GPS
Technical Reference includes information on setting an appropriate HTAU value for the
application.

Time Constants

The VS131 incorporates user-configurable time constants that can provide a degree of
smoothing to the heading, pitch, rate of turn (ROT), course over ground (COG), and
speed measurements. You can adjust these parameters depending on the expected
dynamics of the vessel. For example, increasing the time is reasonable if the vessel is
very large and is not able to turn quickly or would not pitch quickly. The resulting
values would have reduced ‘noise, resulting in consistent values with time. However,
if the vessel is quick and nimble, increasing this value can create a lag in
measurements. Formulas for determining the level of smoothing are located in the
Hemisphere GPS Technical Reference (go to www.hemispheregps.com and click the
GPS Reference icon). If you are unsure on how to set this value, it is best to be
conservative and leave it at the default setting.

Heading Time Constant

Use the $JATT,HTAU command to adjust the level of responsiveness of the true
heading measurement provided in the $GPHDT message. The default value of this
constant is 2.0 seconds of smoothing when the gyro is enabled. The gyro is enabled
by default, but can be turned off. By turning the gyro off, the equivalent default value
of the heading time constant would be 0.5 seconds of smoothing. This is not
automatically done and therefore you must manually enter it. Increasing the time
constant increases the level of heading smoothing and increases lag.

Pitch Time Constant

Use the $JATT,PTAU command to adjust the level of responsiveness of the pitch
measurement provided in the $PSATHPR message. The default value of this constant
is 0.5 seconds of smoothing. Increasing the time constant increases the level of pitch
smoothing and increases lag.
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Table D-3: VS131 L-band sensor specifications

Item Specification
Sensitivity -130 dBm

Channel spacing 7.5 kHz

Satellite selection Manual and automatic
Reacquisition time 15 seconds (typical)
Rejection 15 kHz spacing > 30 dB

300 kHz spacing > 60 dB

Processor DSP for demodulation and protocol decoding module
provides processing for differential algorithms

Command support Reports L-band region and satellite information

Allows input and status of L-band subscription, bit error rate
(BER) output for reception quality indication, and manual
frequency tuning

Table D-4: VS131 communication specifications

Item Specification

Serial ports 2 full-duplex RS-232

USB ports 1 USB-B

Baud rates 4800 - 115200

Data I/0 protocol NMEA 0183, Crescent binary®

Correction 1/0O protocol RTCM v2.3 (DGPS), RTCM SC-104, L-Dif*
Timing output 1 PPS CMOS, active high, rising edge sync, 10 kC2, 10 pF load

Table D-5: VS131 power specifications

Item Specification

Power input voltage 8to 36 VDC

Power consumption < 4.5 W nominal (L1 GPS and L-band)
< 3.6 W nominal (L1 GPS)

Current consumption < 0.38 A nominal (L1 GPS and L-band)
< 0.30 A nominal (L1 GPS)

Power isolation 500 V

Reverse polarity protection | Yes

Antenna short circuit Yes

protection
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VS131 Receiver Specifications

Table D-1 through Table D-7 list the technical specifications of the VS131.

Table D-1: VS131 GPS sensor specifications

Item

Specification

Receiver type

L1, C/A code, with carrier phase smoothing

Signals received GPS
Channels 24
GPS sensitivity -142 dBm

SBAS tracking

2-channel, parallel tracking

Update rate

10 Hz standard, 20 Hz available by subscription

Horizontal accuracy

RMS (67%) 2DRMS (95%)
L-band DGPS service’2 0.3 m 0.6m
SBAS (WAAS)' 0.3m 0.6 m
Beacon’ 0.3 m 0.6 m
Autonomous, no SA' 1.2m 25m

Heading accuracy

<0.33°rms @ 0.5 m antenna separation
<0.17° rms @ 1.0 m antenna separation
<0.08° rms @ 2.0 m antenna separation
<0.03° rms @ 5.0 m antenna separation

Pitch/roll accuracy <1°rms
Heave accuracy 30 cm rms®
Timing (1PPS) accuracy 50 ns

Rate of turn

90°s maximum

Cold start time

< 60 s typical (no almanac or RTC)

Warm start time

< 20 s typical (almanac and RTC)

Hot start time

< 1 s (almanac, RTC, and position)

Heading fix

< 10 s typical (valid position)

Maximum speed

1,850 kph (999 kts)

Maximum altitude

18,288 m (60,000 ft)

Table D-2: VS131 beacon sensor specifications

Item

Specification

Channels

2-channel, parallel tracking

Frequency range

283.5 to 325 kHz

Operating modes

Manual, automatic, and database

Compliance

IEC 61108-4 beacon standard
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Rate of Turn (ROT) Time Constant

Use the $JATT,HRTAU command to adjust the level of responsiveness of the ROT
measurement provided in the $GPROT message. The default value of this constant is
2.0 seconds of smoothing. Increasing the time constant increases the level of ROT
smoothing.

Course Over Ground (COG) Time Constant

Use the $JATT,COGTAU command to adjust the level of responsiveness of the COG
measurement provided in the $GPVTG message. The default value of this constant is
0.0 seconds of smoothing. Increasing the time constant increases the level of COG
smoothing. COG is computed using only the primary GPS antenna and its accuracy
depends upon the speed of the vessel (noise is proportional to 1/speed). This value is
invalid when the vessel is stationary.

Speed Time Constant

Use the $JATT,SPDTAU command to adjust the level of responsiveness of the speed
measurement provided in the $GPVTG message. The default value of this parameter
is 0.0 seconds of smoothing. Increasing the time constant increases the level of speed
measurement smoothing.
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VS131 Receiver Specifications
A21 Antenna Specifications
A31 Antenna Specifications

Vector VS131 GPS Compass User Guide 53 PN 875-0311-000 Rev B1



Chapter 3: Installing the VS131

Mounting the Antennas

Mounting the Receiver

Routing and Connecting the Cables
Connecting the Receiver to External Devices
Default Parameters
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Mounting the Antennas

Hemisphere GPS recommends mounting the antennas first then the mounting the
receiver. When mounting the antennas consider the following:

o Mounting orientation (parallel or perpendicular)

o Proper antenna placement

o Mounting options (magnetic, pole, or rail mounting)

Antenna Options

The standard VS131 kit does not include antennas. Your VS131 kit may contain one of
each or two of one of the following antennas: A21 and A31. For example:

o If you will be using beacon, your kit may include one A31 beacon antenna
and one A21 antenna.

. If you will not be using beacon, your kit may include two A21 antennas.

Mounting Orientation

The VS131 outputs heading, pitch, and roll readings regardless of the orientation of
the antennas. However, the relation of the antennas to the boat’s axis determines
whether you will need to enter a heading, pitch, or roll bias. The primary antenna is
used for positioning and the primary and secondary antennas, working in
conjunction, output heading, pitch, and roll values.

Regardless of which mounting orientation you use, the VS131 provides the ability to
output the heave of the vessel. This output is available via the $GPHEV message. For
more information on this message refer to the Hemisphere GPS Technical Reference
(go to www.hemispheregps.com and click the GPS Reference icon).

Parallel Orientation

The most common installation is to orient the antennas parallel to, and along the
centerline of, the axis of the boat. This provides a true heading. In this orientation:

° If you use a gyrocompass, you can enter a heading bias in the VS131 to
calibrate the physical heading to the true heading of the vessel.

o You may need to adjust the pitch/roll output to calibrate the measurement if
the Vector is not installed in a horizontal plane.

Perpendicular Orientation

You can also install the antennas so they are oriented perpendicular to the centerline
of the boat’s axis. In this orientation:

o You will need to enter a heading bias of +90° if the primary antenna is on the
starboard side of the boat and -90° if the primary antenna is on the port side
of the boat.

. You will need to configure the receiver to specify the GPS antennas are
measuring the roll axis using $JATT,ROLL,YES.

o You will need to enter a roll bias to properly output the pitch and roll values.

° You may need to adjust the pitch/roll output to calibrate the measurement if
the Vector is not installed in a horizontal plane.

Vector VS131 GPS Compass User Guide 14 PN 875-0311-000 Rev B1
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System Setup Menu

The System Setup menu allows you quickly view and edit current system settings.
General settings include such items as current applications, units, baud rates, logs,
LED contrast, subscription code, display orientation (you can flip the display 180° by
selecting YES under Flip Display), and language.

1 In Use > ATTITUD2
2 Other > ATTITUD2
) SwapApplications >
Back >
Top Menu >
Disp Update > 1lHz
LL Unit > DM.M
. | Hgt Unit > meters
| vel Unit > km/h
Back >
Top Menu >
Vector > Display Apps > PORT A > 9600
G?S > Display Format > PORT B > 19200
Diff SBAS > Baud Rates > » Back >
Config Wizard > Software Disp >
Top Menu >
System Setup >— Contrast >
_I—> Animation > Off
Flip Display > NO
LCD Off >
Language >never Menu >
guag RxApp >
Back > S/N >
|-
Top Menu > ""| Authorizations >
Back >
Top Menu >

Figure C-8: System Setup menu
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SBAS > YES
OMNIVBS > YES
OMNIHP > YES
Vector > No DIFF Source ELCH2 BD
A DFX > NO
GPS > Diff > Autonomous
: o CMR > NO
Diff Autonomous > p Back >
Confi i d Top Menu > EINEE) 2 0o
son ig glzar > P ROX > NoO
ystem Setup > Back >
Top Menu >

Figure C-6: Autonomous menu

Vector >

GPS >

Diff Extern RTCM >
Config Wizard >
System Setup >

h 4

RTCM Port > PORT A
RTCM Baud > 19200
Diff > Extern RTCM
Back >

Top Menu >

Figure C-7: External RTCM menu

Config Wizard Menu

The Config Wizard walks you through basic settings to get up and running. See

“Config Wizard Menu” on page 30 to view the Config Wizard menu map.
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Planning the Optimal Antenna Placement

Note: In the VS131 kit, install the A21 antenna as the primary antenna as it is used for
positioning.

Proper antenna placement is important to obtain a high-precision GPS reading. For
the best results, orient the antennas so the antennas’ connectors face the same
direction. Also, place the antennas:

. With a clear view of the horizon
e  Away from other electronics and antennas

° Along the vessel’s centerline

YNWAGLIINER  You must install the primary antenna along the vessel’s
centerline; you cannot adjust the position readings if the primary antenna is
installed off the centerline. Positions are computed for the primary antenna.

° On a level plane
° With a 5.0 m maximum separation (default is 1.0 m)
e  Away from radio frequencies
° As high as possible
Set the MSEP value to be accurate to within 1 to 2 cm. For more information on MSEP

refer to the Hemisphere GPS Technical Reference (go to www.hemispheregps.com
and click the GPS Reference icon).

See Figure 3-1 below through Figure 3-3 on page 16 for mounting orientation
examples.

+
P = primary antenna (A21) P
Forward
S = secondary antenna (A21 or A31%) 4 o motion
*must be A31 if using beacon /
! +H
Receiver |
(display must |
face primary . ~
t ! .
antenna) Antenna
~. separation
(1.0 m default,

5.0 m maximum)

Figure 3-1: Recommended orientation and resulting signs of HPR values
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P = primary antenna (A21
p y (A21) +R Signal Status >|— | F 295.0/200 aa
. Vector > Configure > SS 34 SNR 26
S = secondary antenna (A21 or A31%) , Ges > ("piff > Beacon MTP 100% WER 00
*must be A31 if using beacon B D:.ff.Bea'con > P Tnciude > Unselected Bx
Config Wizard > ID 1025 H 08
- - Back >
ystem Setup > Top Menu > Back >
Top Menu >
SBAS > YES Africa >
Beacon only ) OMNIVBS > YES Asia >
i appears if RTCM2 is | OMNIHP > YES | Tune: 319.0 100 > Australia >
Re_celver setto YES —————( rrcM2 > YES ) Auto Tune > Central America >
(display must L | DFX > NO Ly T > »| Europe >
face primary N~ . Antenna CMR > NO Back > North America > —
antenna) s separation RTCM3 > NO Top Menu > South America >
. ROX > NO Back >
(1.0 m defa-ult, Back > Top Menu >
Forward 5.0 m maximum) Top Menu >
motion
Alexandria VA
Annette IS AK
Bermuda > _
i} R B . . Canada > _
Figure 3-2: Alternate orientation and resulting signs of HPR values usa > >
::CkM:nu = Youngstown NY
, P Back >
: Top Menu >
'
H

Figure C-4: Beacon menu

Freq: 1536.7820
SPS: 1200

BER: 500

.| ILN: -101.0°

| Elev: 49.8°
Az: 160.7°
Back >

Top Menu >

Centerline

Mode > Auto

- - - - Freq: 1536.7820

Figure 3-3: Antenna installation: Cross-section of boat LT: 45° 1IN -122°

B Baud: 1200

Back >

Mounting Options CHepell S >y Top Menu >

Vector > Configure >

You can mount the antennas with a magnetic mount, pole mount, or rail mount @ = Subscription > Begin: 01/06/1980
) : Diff L-Band > DIffR>AT Band End: 03/19/2010

configuration. You can secure the antennas to a threaded pole or threaded mount Config Wizard > Include > optns: DRY

using the included mounting adapters. System Setup > Eoels Type: SINGLE_SIT

S B S | Lib: vBS 2.06

Depending on the antennas included in your kit, you may need to use the included src: 0
antenna height adapters to bring the antennas level. If the adapter is not used, you :2;"M;u s
will need to enter a non-level bias calculation into the system (see “Q: | could not

: f : : o L-Band only appears if
install my antennas at the same height. How do | calibrate for the height offset?” on OMNIVES andior SBAS > YES

page 43 of Appendix B, “FAQ”) OMNIHP are set to YES s s

RTCM2 > NO

DFX > NO
H R A CMR > NO

VYWILGLIINEH The maximum allowable antenna separation is 5.0 m. Any greater RS S =

distance may result in an incorrect heading. ROX > NO

Back >

Top Menu >

P oY

A\ 4

Figure C-5: L-band menu

Vector VS131 GPS Compass User Guide 16 PN 875-0311-000 Rev B1 Vector VS131 GPS Compass User Guide 49 PN 875-0311-000 Rev B1



Appendix C: Menu Map

Chapter 3: Installing the VS131

Differential Menu

Use the Differential menu to view or change your differential settings. The following
available differential sources depend on the configuration you purchased.

e SBAS

. Beacon (RTCM2) - available with purchased unlock code
o L-band (OMNIVBS, OMNIHP) - available with purchased unlock code

. None (Autonomous)

To select the differential source:

1.  Press Differential > Include then set each format you may use to Yes. For
example, if you will be using Beacon, set RTCM2 to Yes. 1.

2.  Press Back to return to the previous menu level, press InUse, then select
your preferred differential source. For example, if you will be using Beacon,
select Beacon (RTCM2 will be displayed when finished).

Figure C-3 through Figure C-8 show the complete menu maps for

menu items will not appear on your menu.

Vector >
GPS >
Diff SBAS >

v

Config Wizard >

Magnetic Mounting

The following procedure assumes your kit contains one A31 beacon antenna and one
A21 antenna. If your kit contains two A21 antennas (no beacon), mount both antennas
in the same manner as outlined in the steps for the A21.

Note: Your kit may not include a magnetic mount.

You can screw the magnetic mount into the bottom of the antenna and mount it to any
metal surface. If there are no metal surfaces, use the zinc disc and foam adhesive
included in your kit to mount the antenna.

To mount the antennas using the magnetic mount:

Select a location and orientation that meet the
requirements outlined in “Mounting Orientation”
on page 14 and “Planning the Optimal Antenna
Placement” on page 15.

2.  A21 antenna only: Unlike the A31, the A21

SBAS > YES i i
the SBAS, Beacon: L-ba!'\d, and Autonomous, respectively. The OMNIVBS > YES 22}2??::%?;2;;:\':3: :;;Tr?g:gdbg;?e:t(l;se at
Include menu (at right) in each of these figures shows all available g!T'JNC;gP; Yﬁz right) using the four screws in your kit.
formats. If you have not purchased unlock codes for L-band and I — ] .
Beacon, the OMNIVBS/OMNIHP (L-band) and RTCM2 (Beacon) i o - 3. Attach the magnetic mount extension to the
RTCM3 > NO magnetic base plate.
ROX > NO
Back > Note: Photos at right and in
Top Menu > step 4 show the zinc disc
attached to the magnetic base
BER 138: 0 plate. You will only need the
BER 133: 0 zinc disc if mounting the
In 138: -107.0° antenna to a non-metal surface
In 133: -97.0° (see steps 6 through 11).
Elev138: 50.7°
GlewAlts  Bod 4. Thread the magnetic mount into the mounting bracket on the bottom of the
:: iig i;;; A21 antenna or into the bottom of the A31 antenna.
Back >
Top Menu > Mode > Auto . . .
Signal Status > PRN1 138 When threading the magnetic mounts, hand tighten only.
Satellites > p PRN2 133 Damage resulting from over-tightening may void your warranty.
Diff > SBAS Back >
Include > SBAS > YES Top Menu >
Back > OMNIVBS > YES
Top Menu > OMNIHP > YES

System Setup >

RTCM2 > NO
DFX > NO
CMR > NO
RTCM3 > NO
ROX > NO
Back >

Top Menu >

Figure C-3: SBAS menu

If you are mounting the antenna on a metal surface, go to step 5.

If you are mounting the antenna on a non-metal surface and need to use the
metal disc and foam adhesive, skip step 5 and complete steps 6 through 11.

Vector VS131 GPS Compass User Guide
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Place the antenna in the desired location, ensuring the antenna is secure in
its mounting position (end of metal surface mounting procedure).

Clean and dry the surface where you will attach the zinc disc.

Remove the backing from one side of the
foam adhesive and press the adhesive
onto the zinc plate (at right).

Remove the backing from the other side
of the foam adhesive and press the zinc
disc onto the mounting surface on the

vessel, applying firm pressure to ensure good adhesion.

Place the antenna on top of the zinc disc, ensuring the antenna is secure in
its mounting position.

Pole Mounting

The following procedure assumes your kit contains one A31 beacon antenna and one
A21 antenna. If your kit contains two A21 antennas (no beacon), mount both antennas
in the same manner as outlined in the steps for the A21.You can pole-mount the
antennas using existing hardware on your vessel.

To mount the antennas using a pole mount:

1.

4,

Select a location and orientation that meet the
requirements outlined in “Mounting Orientation”
on page 14 and “Planning the Optimal Antenna
Placement” on page 15.

A21 antenna only: Unlike the A31, the A21
antenna does not include a threaded mounting
hole. You must attach the mounting base using the
four screws included in your kit (see at right).

Thread the pole mount (not included) into the
mounting bracket on the bottom of the A21
antenna or into the bottom of the A31 antenna.

YNWEAGUIINER When threading the pole mounts, hand tighten only. Damage
resulting from over-tightening may void your warranty.

Mark and drill any mounting holes necessary for the pole mounts.

Vector VS131 GPS Compass User Guide 18
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GPS Menu

Use the GPS menu to view and edit your GPS settings. Settings include the data port
outputs, specific positioning parameters, UTC time offset, and satellite visibility and
positioning information.

Lt 51°00.131035"
Ln 114°00.273158"'
Hgt 1030.400 m
coG 236.65

Vel 10.5 km/h
Age 6.0 s

SV Count 10

HDOP 1.3

—p» o-Lat: 0.200m

Precision >
NavCnd > ABBABB

Azimuth: 163.10°

o-Lon: 0.200m
o-Alt: 0.300m

DSP-ARM > 1F-1F —
Back >
Top Menu >

CHO1-SV23 EL 37
AZ 092 SRN 45

CH12-SV09 EL 45
AZ 183 SRN 47
Back >

Top Menu >

Elev Mask > 5°
MaxDGPSAge > 2700
Data PORT A >

L Above Ele akil
Diff Corr 10
No Diff Corr 0
Back >
Top Menu >

Data PORT B >
UTC Offset > -7Hr
GGAALLGNSS > No
Rx Modes >

’ ARM: DifData YES

Back >
Top Menu >

Back >

Top Menu >

Car Smooth 11
Eph Exists 11

Eph Healthy 10
NotUsed Prev 11

DSP: CarLock YES
DSP: BER YES
DSP: DSPLock YES
DSP: FrmSync YES
DSP: TrkMode YES
ARM: GPSLock YES

ARM: ARMLock YES

ARM: DGPS YES
ARM: Solutn YES
Back >

Top Menu >

Vector > Position Status >
GPS > Satellites >
Diff SBAS > Configure >
Config Wizard > Back >
System Setup > Top Menu >

BASE > NO

FOREST > NO

GPSONLY > NO

L1ONLY > NO

MIXED > NO

NULLNMEA > NO

SBASR > NO

TIMEKEEP > NO <]

TUNNEL > NO

GLOFIX > NO

FIXLOC > NO

SURETRACK > YES

SBASNORTK > NO

Back >

Top Menu >

Figure C-2: GPS menu
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This appendix shows the complete menu map for each menu (listed below) on the
VS131 Top menu:

o Vector

e GPS

. Diff (differential)
° Config Wizard

° System Setup

Vector Menu

Use the Vector menu to view and adjust Vector settings. Options vary depending on
whether you select Pitch or Roll and include such items as aiding features, time
constants, heading bias, and antenna separation.

Heading 180.00
COG 10.00

Vel 25.3 km/h
ROT 3.2

Pitch >

Roll 6.2
Heave >

Back >

Top Menu >

\ 4

Gyroaid > YES
Tiltaid > Yes
Calibrate tilt >
Back >

Top Menu >

\ 4

Vector > —— Display >
GPS > Aiding Features >

HTAU > 0.5
: ! HRTAU > 0.
D:Lff_SBA? > T:.Lme Constani_:s > — COoG > 0.0
Config Wizard > Bias, Neg, Tilt > _\_’ SPEED > O.
System Setup > A{xtenna Sep. >_ PTAU > 0.0
Pitch/Roll > Pitch Back >
Back > Top Menu >
Top Menu >

0

5

Heading > 0.0
Pitch/Roll > 0.0
Neg Tilt > NO
Level Op. > YES
Back >

Top Menu >

\ 4

Computed > 0.550m
Measured > 0.550m
Back >

Top Menu >

\ 4

Figure C-1: Vector menu
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Rail Mounting
You can rail mount the antennas using existing hardware on your vessel.
To rail mount the antennas:

1.  Select a location and orientation that meet the requirements listed in
“Mounting Orientation” on page 14 and “Planning the Optimal Antenna
Placement” on page 15.

2. Use appropriate hardware to securely attach the antenna to the railing.

Routing and Securing the Antenna Cable

VYN\ILGLUINEH The VS131 receiver provides 5 VDC across the antenna ports.
Connection to incompatible devices may damage equipment.

To route and secure the antenna cables, review the following guidelines. The two
enclosed antennas each require a 50 Q impedance antenna extension cable, such as
RG-58U (up to a maximum of 15 m (49 ft.) in length), for proper operation.

° The GPS receiver inside the VS131 requires a minimum input gain of 10 dB
(and maximum of 40 dB before saturation will occur). The antennas offer
28 dB of gain, so the loss budget to accommodate for cable losses is 18 dB.

o Regardless of the cable material and length you choose, ensure the cable
losses are less than 18 dB of attenuation. Due to variances in the antenna
gain and practical attenuation of cable materials and connectors,
Hemisphere GPS recommends reducing this budget to 15 dB; this budget is
present to overcome the resulting attenuation of an RF cable.

. When deciding on an antenna location, consider the amount of cable
required: a longer cable of the same material will result in a higher loss than
a shorter one. If the overall loss of the longer cable exceeds 15 dB, change
the cable material (this normally means a more expensive material that has
a larger diameter and less flexibility). The standard cables included with the
VS131 are of the RG58 material family and their attenuation is ~0.8 dB/m.
Including connector losses, the nominal loss of these RF cables is ~10 dB,
which is within the tolerable loss budget. If a 15 m or 20 m cable run is
required, a RG8 variety is available. If lengths longer than 20 m are required,
more sophisticated materials are required.

For more information on cable length or low-loss cable, contact your dealer or
Hemisphere GPS Technical Support. Table 3-1 provides a summary of readily available
cable materials with 50 Q impedance.

Table 3-1: Cable losses (not including connector losses)

Material Loss at GPS L1 (1.575 GHz)
RG58 0.78 dB/m
RG8 0.36 dB/m
Times Microwave LMR400 0.15 dB/m

For additional cable guidelines see “Routing and Connecting the Cables” on page 21.
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Mounting the Receiver

Hemisphere GPS recommends mounting the antennas first and then the mounting
the receiver. Use the enclosed kit to mount the receiver. When mounting the VS131
receiver, adhere to the following guidelines:

° Install the receiver inside and away from the elements and in a location that
minimizes vibration, shock, extreme temperatures, and moisture

. Position the receiver horizontally with its display facing the primary antenna

. Ensure the front panel (menu screen, LEDs, buttons) is visible and accessible

o Ensure the back panel (ports, connectors) is easily accessible to connect/
switch out cables

Figure 3-4 shows the dimensions (including attached mounting brackets) of the VS131.
Use Figure 3-4 when using the receiver mounting procedure that follows.

F@% 4x 52mm
f 0.20in
1346 mm 1143mm
530in 450in
o
141.6 mm
5.57in

2014 mm
7.93in
749mm || (G
295in =0 O
I ] ¢
* |- 1143 mm
450in
1524 mm
6.00in

Figure 3-4: VS131 dimensions with mounting brackets

To mount the receiver:

1. Locate the thumbscrews, nuts, and brackets included in your kit.

2. Slide the nuts through the
opening (circled at right) along -
both sides of the receiver. Hemisphere ’r

Vector VS131 GPS Compass User Guide 20 PN 875-0311-000 Rev B1
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Vector Menu

GPS Menu
Differential Menu
Config Wizard Menu
System Setup Menu
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3. Place the bracket alongside the
receiver and insert the
thumbscrews (two
thumbscrews per bracket) so
they screw into the nuts.

Hemisphere) CITD

4. Using the remaining holes in Remaining bracket holes
the brackets (two holes per
bracket) screw down the / \
brackets in the desired
location.

Note: Hemisphere GPS does
not provide the screws in
this step.

Remaining bracket holes

Routing and Connecting the Cables

Adhere to the following when routing and connecting cables:

° Power cable must reach an appropriate power source
o Antenna cables must reach from the antennas to the receiver

o Data cable may connect to a data storage device, computer, or other device
that accepts GNSS data

o Do not run cable in areas of excessive heat

o Do not expose cable to corrosive chemicals

o Do not crimp or excessively bend cable

o Do not place tension on cable

o Coil up excess cable near unit

o Secure along the cable route using plastic tie wraps as necessary

o Do not run cable near high voltage or strong RF noise and transmitter
sources

° When connecting the power cable to the power source, ensure the power
source is between 8 V and 36 V

YNWAGUIINER Improperly installed cables near machinery can be dangerous.
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Connecting the Receiver to External Devices

You can connect the VS131 to external devices via Port A and Port B on the back of the
receiver.

1 PPS
©

PRIMARY RF SECONDARY RF

=\ —\
\9 (%) (\O)
=

PORT B

oC Jo

©

Figure 3-5: VS131 port connections

Figure 3-6 shows the pinouts and Table 3-2 provides pinout descriptions for Port A and
Port B. Both ports communicate at the RS-232 interface level with external data
loggers, navigation systems, and other devices.

The default baud rates, NMEA message types, and update rates for both ports are
listed in “Default Parameters” on the following page. If the NMEA data messages you
desire are different from the default values, you will need to select those also. Use the
Config Wizard to select your NMEA message types and update rates per port (see
“Using the Config Wizard” on page 31).

Table 3-2: Port A / Port B pinout descriptions

Pin | Port A Port B
1 Not connected Not connected
@ @ @ ® @ 2 Transmit data Port A Transmit data Port B
@ @ @ (NMEA 0183, binary, (NMEA 0183, binary,
and RTCM input) and RTCM input)
Figure 3-6: Port A and 3 Receive data Port A Receive data Port B
Port B pinouts (NMEA 0183, binary, (NMEA 0183, binary,
and RTCM output) and RTCM output)
4 Not connected Not connected
5 Signal ground Signal ground
(signal return) (signal return)
6 Event marker input Not connected
7 Not connected Not connected
8 Not connected Not connected
9 1 PPS timing output 5V output, 350 mA max

Vector VS131 GPS Compass User Guide
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o The external correction source should be using an 8 data bit, no parity, 1
stop bit (8-N-1) serial port configuration.

° Inspect the cable connection to ensure there are no signs of damage.

o Check the pinout information for the cables to ensure the transmit line of the
external correction source is connected to the receive line of the VS131's
serial port and that the signal grounds are connected.

Save the configuration as the profile named “RTCM” in the Config Wizard, cycle
the power and load the RTCM profile.

Q: Why am | not getting data from the VS131?
A: There are several possible reasons for this. Check the following items.
° Check receiver power status LED to ensure the receiver is powered.

e  Verify the VS131 is locked to a valid DGPS signal (this can often be done on
the receiving device or with VectorPC).

° Verify the VS131 is locked to GPS satellites (this can often be done on the
receiving device or with VectorPC).

o Check the integrity and connectivity of power and data cable connections.

Q: Why am | getting random data from VS131?
A: There are three possible reasons for this. Check the following items.

o Verify the RTCM or the Bin95 and Bin96 messages are not being output
accidentally (send a $JSHOW command).

o Verify the baud rate settings of VS131 and remote device match correctly.

o Potentially, the volume of data requested to be output by the VS131 could be
higher than the current baud rate supports. Try increasing the baud rate to
38400 for all devices or reduce the amount of data being output.

Q: | could not install my antennas at the same height. How do | calibrate for
the height offset?

A: You may enter an non-level bias calculation that adjusts the pitch/roll output to
calibrate the measurement if the antenna array is not installed on a horizontal plane.

To calibrate the pitch/roll reading, send the following command:
$JATT,PBIAS, x<CR><LF>

where x is a bias (in degrees) that will be added to the pitch/roll measurement.
The acceptable pitch bias range is -15.0° to 15.0° (default is 0.0°).

To determine the current pitch compensation angle, send the following command:
$JATT,PBIAS<CR><LF>

The pitch/roll bias is added after the negation of the pitch/roll measurement (if so
invoked with the $JATT,NEGTILT command).
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This appendix covers power, communication and external RTCM questions. For GPS
and Heading troubleshooting, see Chapter 4, “Operating the VS131.”

Q: Can COAST technology work with corrections from an external source?

A: Yes, the VS131 will operate in a similar fashion with COAST technology as when
using SBAS or Beacon corrections. However, SBAS corrections have the advantage
that they are separated into separate error components, allowing the VS131 to
anticipate how errors will change over the coasting period with more consistent
accuracy and for a longer period than regular RTCM range corrections.

Q: My VS131 does not appear to be communicating. What do | do?
A: This could be one of the following issues:
o Examine the power cable and its connector for signs of damage.

o Ensure you are properly powering the system with the correct voltage (8 to
36 VDC) by measuring the voltage at the receiver end of the power cable
when the cable is connected to the power source.

o Check current restrictions imposed by power source (minimum available
should be > 1.0 A).

e  Verify the display has turned on and that time is incrementing in the upper
right corner of the display, and configure the COM port baud rates
appropriately through the menu system.

° Verify polarity of power leads.
o Check the 1.0 A inline power cable fuse.

° Since you are required to terminate the power input with your choice of
connector, ensure you have made a good connection to the power supply.

. Consult the troubleshooting section of the other device’s reference manual
to determine if there is an issue with that device.

Q: Am | able to configure the two serial ports with different baud rates?

A: Yes, the ports are independent. For example, you may have one port set to 4800
and the other to 19200 or vice versa.

Q: Am | able to have the VS131 output different NMEA messages through
the two ports?

A: Yes, you may have different NMEA messages turned on for the two serial ports.
Further, these NMEA messages may also be at different update rates.

Q: How do | determine the current configuration of the VS131?

A: You can view the current configuration from various screens of the menu, which
show all configurable items of the receiver. Alternately, you can select Config Wizard
> Use Previous to return the receiver to a previously saved (known) configuration.

Q: My VS131 does not appear to be using corrections from an external
correction source. What could be the problem?

A: This could be due to a number of issues. Check the following items.
° Make sure the corrections are of an RTCM SC-104 protocol.

° Verify the baud rates of the port used by the VS131 match that of the external
correction source.
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Default Parameters

The following represents the standard configuration for the VS131. For more
information on these commands refer to the Hemisphere GPS Technical Reference (go
to www.hemispheregps.com and click the GPS Reference icon).

Note: Use the $JSAVE command to save changes you make to the VS131
configuration for the changes to be present in subsequent power cycles. Also, if you
change any default values and then issue a $JRESET command verify your settings
to make sure you consistently get a correct heading. To reset the VS131 to its default
parameters you can re-install the configuration file (shown below)—contact your
dealer or Hemisphere GPS Technical Support for information on obtaining and
re-installing the configuration file.

SJOFF, PORTA
$JOFF, PORTB
$JOFF, PORTD

$JAGE, 2700
$JLIMIT, 10

SJWAASPRN, AUTO
$JDIFF, LBAND
$JP0S,51.0,-114.0
$JSMOOTH, LONG
$JTAU, COG,0.00
$JTAU, SPEED, 0.00
$JAIR,AUTO

$JALT, NEVER

$JATT,ACC180, YES
$JRELAY, PORTC, SMENUOPTIONS, ACC180, ON, TRUE
$JATT, HTAU, 2.0
$JATT, HRTAU, 2.0
$JATT, COGTAU, 0.0
$JATT,MSEP, 1.0
$JATT, GYROAID, YES
$JATT, TILTAID, YES
$JATT, LEVEL, NO
$JATT, EXACT, NO
$JATT, HIGHMP, NO
$JATT, FLIPBRD, NO
$JATT, HBIAS, 0.0
$JATT, NEGTILT, NO
$JATT, NMEAHE, 1
$JATT, PBIAS, 0.0
$JATT, PTAU, 0.5
$JATT, ROLL, NO
$JATT, SPDTAU, 0.0

$JASC, GPGGA, 1.0, PORTA
$JASC, GPVTG, 1.0, PORTA
$JASC, GPGSV, 1.0, PORTA
$JASC, GPZDA, 1.0, PORTA
$JASC, HEHDT, 1.0, PORTA
$JASC, HEROT, 1.0, PORTA
SJASC, GPGGA, 1.0, PORTB
$JASC, GPVTG, 1.0, PORTB
$JASC, GPGSV, 1.0, PORTB
$JASC, GPZDA, 1.0, PORTB
$JASC, HEHDT, 1.0, PORTB
$JASC, HEROT, 1.0, PORTB

$JBAUD, 19200, PORTA
$JBAUD, 19200, PORTB
$JSAVE
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Powering the Receiver On/Off

LED Indicators

Startup

Using the Menus

Configuring the VS131

Disabling the Aiding Features

Adjusting the Time Constants

Connecting to Existing Navigation Systems
Viewing GPS/DGPS Status
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Powering the Receiver On/Off

The power button on the VS131 is located on the front panel (circled below). When
you first apply power to the unit it turns on.

© o ©
VECTOR VS131

HEADING &

- /2\
6
\V

Cros(ent

©

Figure 4-1: VS131 front panel with power button

The VS131 accepts an input voltage of 8 to 36 VDC via the power cable. The supplied
power should be continuous and clean for best performance. Table D-5 on page 55
provides the power specifications of the VS131.

YWILGLINEH Do not apply a voltage higher than 36 VDC. This will damage the
receiver and void the warranty. Also, do not attempt to operate the VS131 with the
fuse bypassed as this will void the warranty.

The VS131 features reverse polarity protection to prevent damage if the power leads
are accidentally reversed. Although the VS131 proceeds through an internal startup
sequence when you apply power, it will be ready to communicate immediately.

Initial startup may take 5 to 15 minutes depending on the location. Subsequent
startups will output a valid position within 1 to 5 minutes depending on the location
and time since the last startup.

The VS131 may take up to 5 minutes to receive a full ionospheric map from SBAS.
Optimum accuracy is obtained once the VS131 is processing corrected positions using
complete ionospheric information.

To power on the VS131:
1. Connect the ends of the VS131 power cable to a clean power source
providing 8 to 36 VDC.

Note: Hemisphere GPS recommends you use a weathertight connection
and connector if the connection is located outside.

2. Press and hold the soft power switch on the front panel until the splash
screen appears.
To power off the VS131:

o Press and hold the soft power switch on the front panel until the screen goes
blank.
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Table A-1: Troubleshooting (continued)

Symptom

Possible Solution

No heading or incorrect
heading value

e Check CSEP value is fairly constant without varying
more than 1 cm (0.39 in)—larger variations may
indicate a high multipath environment and require
moving the receiver location

The standard antenna mounting configuration
provides a 0.5° heading accuracy at 95% confidence. If
you require more performance, you will need to
increase the antenna separation (maximum
recommended separation is 5.0 m). See Table D-1 on
page 54 for antenna separation specifications.

e Recalibrate the tilt sensor with $JATT, TILTCAL
command if heading is calculated then lost at
consistent time intervals

e Heading is from primary GPS antenna to secondary
GPS antenna

e  S$JATT,SEARCH command forces the VS131 to acquire
a new heading solution (unless gyro is enabled)

e Enable GYROAID to provide heading for up to three
minutes during GPS signal loss

e Enable TILTAID to reduce heading search times

e Monitor the number of satellites and SNR values for
both antennas within VectorPC—at least four satellites
should have strong SNR values

e Potentially, the volume of data requested to be output
by the VS131 could be higher than the current baud
rate supports (try using 19200 as the baud rate for all
devices or reduce the amount of data being output)

No DGPS position in
external RTCM mode

e Verify the baud rate of the RTCM input port matches
the baud rate of the external source

e Verify the pinout between the RTCM source and the
RTCM input port (transmit from the source must go to
receive of the RTCM input port and grounds must be
connected)

e Ensure corrections are being transmitted to the correct
port—using the $JDIFEPORTB command on Port A will
cause the receiver to expect the corrections to be input
through Port B
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Table A-1 provides troubleshooting for common problems.

Table A-1: Troubleshooting

Symptom Possible Solution

Receiver fails to power e Verify polarity of power leads
e Check integrity of power cable connectors
e Check power input voltage (8 to 36 VDC)

e Check current restrictions imposed by power source
(minimum available should be > 1.0 A)

No data from VS131 e Check receiver power status to ensure the receiver is
powered (an ammeter can be used for this)

e Verify desired messages are activated (using VectorPC
or $JSHOW in any terminal program)

e Ensure the baud rate of the VS131 matches that of the
receiving device

e  Check integrity and connectivity of power and data
cable connections

Random data from VS131 e Verify the RTCM or binary messages are not being
output accidentally (send a $JSHOW command)

e Ensure the baud rate of the VS131 matches that of the
remote device

e Potentially, the volume of data requested to be output
by the VS131 could be higher than the current baud
rate supports (try using 19200 as the baud rate for all
devices or reduce the amount of data being output)

No GPS lock e Verify the VS131 has a clear view of the sky

e  Verify the lock status of GPS satellites (this can be done
with VectorPC)

No beacon lock e Verify the receiver is tuned to the correct frequency and
bit rate

e Ensure beacon signal coverage is expected in your
area

e Ensure environmental noise is not masking the signal,
reducing the SNR reading

No SBAS lock e Verify the VS131 has a clear view of the sky

e  Verify the lock status of SBAS satellites (this can be
done with VectorPC - monitor BER value)

e Set SBAS mode to automatic with the
$JWAASPRN,AUTO command

SBAS lock is only possible if you are in an appropriate
SBAS region; currently, there is limited SBAS availability in
the southern hemisphere.
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LED Indicators

The VS131 includes five LEDs located to the
left of the display on the front panel (shown at HEADING (&
right).

DIFF &=

Table 4-1 below describes each LED indicator.
EC GPS

PRIM GPS &

POWER (==

Figure 4-2: VS131 LEDs
Table 4-1: LED indicators

Indicator Description/Function

HEADING Valid GNSS heading available

llluminates solid green when the receiver achieves a valid heading
solution from the GNSS receiver. You must see PRIM GPS and SEC GPS
illuminated before a heading solution is possible.

If the GNSS solution is no longer available, the LED turns off.

DIFF DGPS position indicator

Illuminates solid green when the receiver achieves a differential position
and a pseudorange residual of better than 10.0 m.

If the residual value is worse than the current threshold, the LED blinks

green indicating differential mode has been attained but the residual has
not met the threshold.

SEC GPS Secondary antenna is tracking 4 or more satellites

llluminates solid amber when the secondary antenna is tracking four or
more satellites.

PRIM GPS Primary antenna is tracking 4 or more satellites

Illuminates solid amber when the primary antenna is tracking four or
more satellites.

POWER Power indicator

Illuminates solid red when the receiver is powered on.
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Startup

When you power on the VS131 the Hemisphere

GPS splash screen appears followed by the main I'II.I.'I.I.._ 22:25:53
screen, or Top menu (see at top right). Press the Vector)

Down Arrow button to display the remaining items

on the Top menu (see at bottom right). GPS)»

You use the menus to view and configure system Differential)

data and settings for the following Top menu

items:
o Vector ﬂ

e GPS

° Differential

. Config Wizard Mol N 22:25:53

Config Wizard )

° System Setup

For a complete menu path of each Top menu item, System Setup)

see Appendix C, “Menu Map.” Vector )

Appendix A: Troubleshooting
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Using the Menus

The VS131 menu system is designed for
easy setup and configuration of the unit in
or out of the field and supports multiple
languages. You can perform most
configuration tasks entirely through the
menu without having to connect to a
computer.

The VS131 front panel contains the three
soft buttons shown at right. The Enter
button also functions as the power switch
(see “Powering the Receiver On/Off” on
page 26 for more information).

Table 4-2 describes the indicators to the
right of specific menu items.

Table 4-2: Menu item indicators

Up Arrow button - moves to
the previous menu item or to
the previous selection within
a menu item

Enter button - displays a
submenu or selects an option
within a menu item

Down Arrow button - moves
to the next menu item or to
the next selection within a
menu item

e  Press Enter when
“Back” is selected to
return to the previous
menu.

e Press Enter when “Top
Menu” is selected to
return to the Top menu.

Scrolls within a menu to
highlight an option to select.

Select
indicator

Indicator Purpose Example
Goes to the indicated 1. On the Top menu press the Down
submenu. Arrow button to highlight System
This indicator also appears Setup. The Display indicator appears to
to the right of the “Back” the rlght of System Setup.
Displa and “Top Menu” menu 2. Press Enter to display the System Setup
o 'spiay items. menu.
indicator

3. Press the Down Arrow button again to
highlight the Display Format option and
then press Enter. The items on the
Display Format menu appear and the
Select indicator appears to the right of
Disp Update (the first item on the
Display Format menu).

4. Press Enter on the Disp Update item.
The Display indicator changes to the
Select indicator.

5. Press the Up Arrow or Down Arrow
button to scroll through the available
options (such as 1Hz and 5Hz).

6. Press Enter on the highlighted option to
select it. That option is now the setting
for the menu item and the Select
indicator changes back to the Display
indicator.

To return the menu system to the factory default configuration:

o Press and hold the Enter and Up Arrow buttons until the splash screen
disappears (Enter and Power share the same soft switch).
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Configuring the VS131

The Config Wizard menu guides you through various configuration options, enabling
you to save up to five different configurations that are useful when using the VS131 on
different vessels or for different applications.

If you use a Windows PC or Windows mobile device, you can use Hemisphere GPS’
VectorPC software to configure the VS131. See “Using VectorPC to Communicate with
the VS131” on page 4 for more information.

Config Wizard Menu

This section describes the basic Config Wizard options you need to set to get up and
running. Figure 4-3 outlines the menu structure of the Config Wizard menu.

GPGGA > Off
GPGLL > Off
GPGNS > Off
GNGNS > Off
GPGSA > Off
GNGSA > Off
GPGST > Off
GPGSV > Off
GLGSV > Off
GPHDT > Off
GPHEV > Off
HPR > Off

: >
Vector > Wizard > P Create New > ____ 5 Ex_mte: Name > A PASHR > Off
GPS > Delete Saved > Save Current > Diff > SBAS come 5 Off
Diff SBAS > Use Previous > Back > Data PORT A > coROT 5 Off
Config Wizard > Cancel > Top Menu > Data PORT B > conEE 5 Off
System Setup > Elev Mask > 5
TSS1 > Off
MaxDGPSAge > 3600
PORT A > 9600 GEVIG > OFf
GPZDA > Off
Pg:inn & BT S > Intir > ofe
iy g S Binl > Off
: : Bin2 > Off
{-Bias, Neg, Tilt >
Bin62 > Off
Ant. Sep > 0.500m :
: ; Bin65 > Off
e > 0.5 Pitch/Roll > Pitch e & o
v HRTAU > 0.0 Heading > 0.0 save to Location > | ey n
Gyroaid > YES coe > 0.0 Pitch/Roll > 0.0 Back > Y =@
Tiltaid > YES SPEED > 0.5 Neg Tilt > NO Top Menu > B 2 @R
Calibrate tilt > BTAU > 0.0 Level Op. > YES RE) > G
Back > Back > Back > ?“:: Z g::
Top Menu > Top Menu > L0
> Top Menu > & Bing5 > Off
Bin%6 > Off
Save to Location > Bind7 > Off
Not Usedl > Bin98 > Off
Not Used2 > Bin99 > Off
Not Used3 > Binl00 > Off
Not Usedd > RD1 > Off
Not Useds > Back >

Figure 4-3: Config Wizard menu
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Connecting to Existing Navigation Systems

Most users connect the VS131 to their existing navigation system during installation.
These users will receive the VS131’s position and heading updates through the
interface of their existing system.

Viewing GPS/DGPS Status

Most users will receive position and heading information through their on-board
navigation system. If you have not connected the VS131 to an existing navigation
system, or are troubleshooting your unit, you may need to view GPS, DGPS, or
Beacon status on the VS131’s display screen.

Do | Have a Signal?

Figure 4-2 on page 27 shows which LEDs on the VS131 will indicate GPS, DGPS or
Beacon signal lock when illuminated. If you lose the differential signal lock,
Hemisphere GPS COAST technology allows the VS131 to perform well for 40 minutes
or more with aging differential GPS correction data. The amount of time you can
“coast” depends on the degree of tolerable drift.

Note: To obtain a full set of SBAS corrections, the VS131 must receive the
ionospheric map over a period of a few minutes. After this, the receiver can “coast”
until the next set of corrections has been received.

How Good is the Quality of My Signal?

In addition to the LED indicators for signal lock, the
VS131's display indicates signal quality. The bars
along the top of the display represent the quality of
the GPS and DGPS (or if applicable, beacon) signal.
The first group of bars shows the GPS signal; the
second group shows the DGPS or beacon signal. Each GPS signal DGPS or beacon
bar represents a distinct channel and its associated indicator
signal quality. The higher the bar, the better the signal.

signal indicator

Note: If using autonomous or external correction mode, the DGPS signal indicator
will not appear in the display.

DGPS (SBAS)

The differential correction (or SBAS) signal indicator reflects the quality of each
satellite signal, or the bit error rate (BER). A full bar height reflects a signal lock and a
BER of 0. A bar height only 2 pixels tall reflects a signal loss, or BER, of 500 or greater.
Bar heights in between reflect intermediate degrees of signal quality. For example,
when using WAAS two satellites are available, so two BERs are provided.

Beacon

The beacon indicator reflects the quality of the beacon signal, or the signal strength
(SS) and the signal-to-noise ratio (SNR). A full bar height reflects a signal lock,
SS>=35, and SNR>=24. A bar height only 2 pixels tall reflects a signal loss, or SS and
SNR values of 0. Bar heights in between reflect intermediate degrees of signal quality.
If using beacon, the first bar indicates SS signal quality; the second bar indicates SNR
signal quality.
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Adjusting the Time Constants

The VS131's default settings are fine for most users; however, you can set the time
constants to further smooth heading, course-over-ground (COG), and speed
measurements. Table 4-3 provides an overview of the time constant values you can
set in the Config Wizard, including the formulas for finding the optimal value of each
time constant for your vessel.

Table 4-3: Time constants

LD Description
Constant P
COGTAU Adjust the responsiveness to the course over ground measurement. If
(Course Over | vessel is small and dynamic, leave this value at 0.0 s to be conservative.
Ground) If the vessel is large and resistant to motion, you may want to increase
this value.
Default value: 0.0 s
Range: 0.0to 60 s
Formula: cogtau (s) = 10 / max rate of change of course (O/sec)
HRTAU Adjust the responsiveness to the rate of heading change. If vessel is large

(Rate of Turn) | and unable to turn quickly, you may want to increase this value.

Default value: 2.0 s with gyro enabled
Range: 0.0to 60 s

Formula: hrtau (s) = 10 / max rate of the rate of turn (O/sz)

HTAU Adjust the responsiveness to true heading. If vessel is large and unable
(Heading) to turn quickly, you may want to increase this value.

For longer baselines (5 m) HTAU should be between 0.5 and 1.0, since the
gyro introduces noise.

Default value: 2.0 s with gyro enabled
Range: 0.0to 60 s

Formula: htau (s) = 40 / max rate of turn (°/s) with gyro ON

htau (s) = 10 / max rate of turn (O/s) with gyro OFF

PTAU Adjust the responsiveness to pitch. If vessel is large and unable to pitch
(Pitch) quickly, may want to increase this value.

Default value: 0.5 s
Range: 0.0to 60 s

Formula: ptau (s) = 10 / max rate of pitch (o/s)

SPDTAU Adjust the responsiveness to speed. If vessel is small and dynamic, leave
(Speed) this value at 0.0 s to be conservative. If the vessel is large and resistant to
motion, you may want to increase this value.

Default value: 0.0 s
Range: 0.0to 60 s

Formula: spdtau (s) = 10 / max acceleration (m/s?)
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Using the Config Wizard
The basic setup instructions outlined in this section assume the antennas are:

° Installed parallel to, and along the centerline of, the vessel’s axis
o Separated by 1.0 m

If this is not the case, you will need to enter the actual antenna separation and bias in
the Config Wizard.

1.  Select Config Wizard > Proceed Wizard. The Proceed Wizard menu
appears.

2. Select Create New to create a new configuration.

Enter Name > A
You are prompted to enter a name for your

Diff > SBAS

configuration. In addition to the Name you can set Data PORT A >
the options shown at right (also shown in Data PORT B >
Figure 4-3 on the previous page). Elev Mask > 5

MaxDGPSAge > 3600
PORT A > 9600

Note: For help on using the menus to view and o B > O

set values see “Using the Menus” on page 29. Aiding Features >
Time Constants >
3.  Enter a name: Bias, Neg, Tilt >
Ant. Sep > 1.000m
a. Use the arrow buttons to select a character Pitch/Roll > Pitch
and then press the Enter button to save the Save to Location >
character. The cursor moves to the right. Eackiy
Top Menu >

b. Repeat step a for each additional character in
the name.

c.  Scroll through the list of characters until you reach “.1” and press the
Enter button to accept the name. You are returned to the previous
menu and the name you entered appears next to “Enter Name.”

If you are editing an existing name, for characters you want to replace
simply select a different character. If the new name is shorter and you need
to delete unneeded characters to the right:

a. After you change the final character in the new name press the Enter
button repeatedly until the last character is highlighted.

b.  Scroll through the list of characters until you reach “4” and press the
Enter button to delete the character. The cursor moves to the left.

c. Repeat step b for each additional rightmost character you want to
delete.

d. Scroll through the list of characters until you reach “.1” and press the
Enter button to accept the name. You are returned to the previous
menu and the name you entered appears next to “Enter Name.”

4.  Set a DGPS source: From the same menu, select DIFF. The options are:

SBAS (default)

Beacon

Autonomous

L-Band

Extern RTCM (External RTCM)

5. Change the type of GPS data message sent to the data ports: Select either
Data Port A or Data Port B from the menu list.

Vector VS131 GPS Compass User Guide 31 PN 875-0311-000 Rev B1



Chapter 4: Operating the VS131

6. Set the elevation cutoff angle: Select Elev Mask and set the angle between
0° and 45°. The default value is 5°.

7. Set the maximum DGPS age: The maximum DGPS age is 2700 seconds (45
minutes) by default.

8. Configure baud rates: If the default baud rate on the selected port does not
match that of the external device you are connecting to, you will need to
configure the Baud Rate, using the Port A or Port B entries.

4800, 9600, 19200, 38400, 57600, and 115200 are the available baud rates.

9. Enable/disable aiding features: The Aiding Features menu enables you to
turn the gyroaid and tiltaid features on or off. For more information on
disabling the aiding features, see “Disabling Tilt Aiding” on page 33 or
“Disabling Gyro Aiding” on page 33.

10. Adjust time constants: While the default time constants settings will work for
most users, if you have a large, slow turning vessel or a small, quick moving
vessel you may want to adjust the time constants to reduce heading start up
and re acquisition times.

For details on configuring the time constants, see “Adjusting the Time
Constants” on page 34.

1. Enter a heading bias: If you did not install the antenna’s parallel to and along
the vessel's centerline, you will need to enter a heading bias in the Heading
field of the Bias, Neg, Tilt menu. The heading bias (-180° to +180°)
compensates for any offset from the centerline.

Note: If you installed the antennas for roll (perpendicular to the boat’s
axis), rather than pitch, you must enter the heading bias (+/-90°). You must
also enter the bias for roll (see below).

12. Enter a pitch/roll bias: Enter the bias for pitch or roll (-15° - +15°) to
compensate for any offset from the boat’s centerline. Enter this bias in the
Pitch/Roll field of the Bias, Neg, Tilt menu.

13. Enter the antenna separation: If you did not install the antennas 1.0 m apart,
enter the actual antenna separation In the Ant. Sep field. The available range
is0-5.0m.

14. Configure antenna for roll: Most users install the antennas for pitch;
however, if you install the antennas for roll, you will need to configure the
VS131 for roll. In the Create New menu set the Pitch/Roll setting to Roll.

15. Save your configuration: To save your new configuration, select the Save to
Location field. You will be prompted for a location to save your
configuration.

Select one of the empty slots, noted by the name Not Used or select a slot
with an existing configuration to overwrite it.

After your configuration is saved, you must select it from the Config Wizard
in order to activate it. You may then continue to enter different receiver
configurations without upsetting the current operation of the receiver. Re-
enter the Config Wizard and select the configuration to use.
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Disabling the Aiding Features

While the default settings will work for most users, you can configure the tilt and gyro
aiding features to further reduce heading startup and re-acquisition times.

Disabling Tilt Aiding

The VS131’s tiltaid (accelerometer) is enabled by default and constrains the RTK
heading solution to reduce startup and re acquisition times. The tiltaid is precalibrated
at the factory; however, if you experience any tilt measurement offset, you can
recalibrate the tilt sensor via the Calibrate Tilt option in the Vector menu. See “Vector
menu” on page 46 for a menu map on how to access this feature.

Note: Make sure the receiver is perfectly level before recalibrating the tiltaid.

The only times you may need to disable the tiltaid feature are:

° If you were unable to install the VS131 on a level plane with the antennas.
The tilt sensor is located inside the VS131, so it is important that you install
the VS131 on a level horizontal plane.

VWILGLUINEH  If you were unable to install the VS131 in a horizontal plane
with the antennas, you must disable tiltaid. Failure to do so may cause
erratic equipment behavior.

o If troubleshooting, to ensure the receiver is working properly.

You can turn tilt aiding off either through the Config Wizard or Vector menus.

Disabling Gyro Aiding
The VS131’s internal gyro-aid is enabled by default. The gyro:

o Shortens re-acquisition times when satellites are obstructed and heading is
lost, by reducing the search volume required for the RTK solution, and

o Provides accurate substitute headings for a short period (depending on the
roll and pitch of the vessel) ideally seeing you through to re-acquisition.

The only time you might need to disable the gyro-aid is during troubleshooting, to
ensure the receiver is working properly.

YNWAGLIINER Do not exceed turn rates of 90%sec. The VS131 uses gyro
measurements to obtain a heading rate measurement and the gyro cannot measure
beyond this rate.

You can turn the gyroaid feature off either through the Config Wizard menu or the
Vector menu.
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